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I nt I'Od u CﬁOn (Ask a Question)

Scalable Low-Voltage Signaling with Embedded Clock (SLVS-EC) is an advanced interface standard pioneered
by Sony Semiconductor Solutions Corporation (SSS) specifically designed for rapid and high-definition image
sensor transmission. It streamlines the process of constructing camera setups. Equipped with an integrated
clock signal, it proves beneficial for scenarios demanding expanded capacity, enhanced speed, or extended
transmission ranges.

SLVS-EC expands our extensive range of Smart Embedded Vision IPs, empowering high-speed video
applications tailored for intelligent-edge devices. For more detailed information, see Smart Embedded Vision
page.

The technical demonstration of the PolarFire SLVS-EC Video Demo operates seamlessly with the PolarFire video
kit, SLVS-EC FMC device and an HDMI monitor. This document serves as a comprehensive guide to facilitate the

execution of the demo. The design of the demo represents a fully integrated solution crafted using Microchip's
Libero® SoC Design Suite.

This document describes the PolarFire SLVS-EC Video Demo, demonstrating integration with the PolarFire video
kit and providing detailed instructions. The demo showcases the following functions:
1. Supports 4K video capture over SLVS-EC FMC camera and cropped to 1080p60 video output over HDMI 2.0.

2. Implements Image Signal Processing (ISP) pipeline on a raw video data.
3. Provides GUI-based image parameter controls.
4. Supports the Auto Exposure Control.

The SLVS-EC Receiver IP core offers an SLVS-EC interface for PolarFire® FPGA, is a compact receiver IP that
adheres to the SLVS-EC V2.0 standards. By combining this IP with FPGA's high-speed transceiver, this IP
facilitates the extraction of pixel clock and data through the high-speed serial embedded clock/data from the
image sensor. This IP core supports configurations of two, four, and eight lanes, with speeds up to 4.752 Gbps
per lane, and data types of Raw 8, Raw 10, and Raw 12 formats. Additionally, the SLVS-EC Rx IP core supports
three Baud Rates, as listed in the following table.

Table 1. Supported SLVS-EC Baud Rate
1 1188
2 2376
3 4752
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1. Demo Requirements (s auestion)
The following table lists the hardware and software required for running the demo.

Table 1-1. Demo Requirements
Hardware and Accessories

MPF300-VIDEO-KIT-NS
Kit Contents:

* PolarFire Video and Imaging board with MPF300T-1FCG1152E Device
+ Dual Camera Sensor board - VIDEO-DC-DUALCAM

+  HDMI cable

+ 12V power pack/AC adapter

+ USB 2.0 A male to mini-B

PolarFire® video kit

SLVS-EC FMC VIDEO-DC-SLVS

HDMI Monitor 1920 x 1080, 60 Hz resolution monitor for the HDMI 2.0 transmitter (Tx) port
Software

Program Debug v24.1 win.exe This executable file installs FlashPro Express, used to program FPGA
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2. Demo Prerequisites (s auestion)
Before you begin, perform the following steps:

+ Download the design files from the following link: AN5188: PolarFire SLVS-EC Video Demo
« Download and install the Libero® SoC Design Suite from Libero SoC Software Downloads
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3. Design Description (sa question)
The following figure shows a high-level block diagram of the design.

Figure 3-1. Block Diagram

PF_DDR4 UART IP
IMX 530
FMC SLVS_EC . DDR
Daughter [ XCVR [—>|Core PCSI—» “" DDR Write C——0) arpiter ——] PDR Read
Card I
Video
Processor Processing|
APB HDMI 2.0 Full HD
Sub Interface BI.OCk & X XCVR Monitor
System Display
Controller

The following steps outline the preceding block diagram:
1. The IMX-530 SLVS FMC captures video data through the transceiver (XCVR), passes it to the Core
PCS, and finally routes it to the SLVS-EC Rx IP.

2. The SLVS-EC Rx IP decodes the SLVS-EC format and generates RAW pixel output, which is stored
in the DDR memory as a video frame (consisting of PolarFire® DDR4, DDR Write, DDR Read, and
DDR Arbiter).

3. The Raw video frame is read back and processed through the video pipeline consisting of Bayer
interpolation, Gamma correction, and Image enhancement.

4. The processed video is streamed over HDMI output by using Display Controller and HDMI 2.0 Tx
IP.

5. This design also integrates a separate processing block, the PROC_SUB_SYSTEM, which is
responsible for initializing the IMX-530 camera through the 12C interface.
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3.1 Hardware Implementation (asa question)
The following figure shows the Libero SoC implementation of the top-level SmartDesign.

Figure 3-2. High-Level SLVS-EC Design

UART interface 0 ey

HOMI_2P0_FHD_TX_0 J
.

The SLVS-EC design includes the following key blocks:

HDMI_2P0_FHD_TX (TX_PLL, HDMI 2.0 TX, and XCVR)

Video_Pipelining_Block (DDR Write, DDR Read, DDR AXI4 Arbiter, and Display Controller)
IMX_TOP (SLVS-EC RX, Core PCS, and XCVR)

Video Processing Block (Bayer_Interpolation, Gamma_Correction, and Image_Enhancement)
PF_DDR4

PROC_SS (MIV_RV32, CoreGPIO, PF_SRAM_AHBL_AXI, and COREI2C)

UART Interface (COREUART)

XCVR Configuration -1

The transceiver configuration for HDMI Tx implementation is shown in the following figure. The
transceiver is configured in Tx only mode in 4 lane configuration. The clock signal is carried by
LANEO, while lanes 1, 2, and 3 carry the blue, green, and red video signals. The transceiver is
configured for Full High Definition (FHD) which is 1920 x 1080p at 60 frames per second. This
configuration is labeled as XCVR Configuration -1, as shown in the following figure.
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Figure 3-3. XCVR Configuration -1
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XCVR Configuration -2

The SLVS-EC Rx is configured to operate in an 8-lane mode and hence, 8-transceiver Rx-lanes are
required to receive the video data. The PolarFire FPGA implements transceiver lanes grouped in
quads, each consisting of four lanes. Hence, two transceiver quads are used to implement 8-lane
configuration. Both the quads use the same configuration as shown in the following figure.

Figure 3-4. XCVR Configuration -2

Transceiver Interface

CorePCS Configuration

CorePCS consists of a user interface and a transceiver interface. The user interface includes transmit
and receive data functionalities, along with various control and status signals that qualify the data.
The Core PCS IP in the design, the LANE_MODE is set to Receiver Only with EPCS_Data_Width as 40
bit, Comma(s) to detect is configured as “K28.5", and No. of commas is configured to “1”, as shown in
the following figure.
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Figure 3-5. CorePCS Configuration

€ configurstion l

Core Configuration

LANE_MODE: Receiver Only -
EPCS_Data_Width: |40bit -

Word Alignment Configurstion

Comma(s) to detect : K285 - ShiftEnzble: [
No. of commas to detect : [Configurable - No. of commas : |1 [1]

Testbench: |User *

SLVS-EC Rx IP Configuration
SLVS-EC Rx IP has the following configuration options:
+ DATA WIDTH has configuration options as Raw 8, Raw 10, and Raw 12

« LANE WIDTH has configuration options as two lanes, four lanes, and eight lanes
+ Video Interface has configuration options as Native and AXI4 Stream

For more information about SLVS-EC Rx IP, see UG0877: SLVS-EC Receiver for PolarFire FPGA user
guide.

The SLVS-EC Rx IP is configured with a native interface, which uses a Raw 8 configuration and a
8-lane width.
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Figure 3-6. SLVS-EC Rx IP Configuration using Raw 8 and 8-Lane Width for Native Interface
Configuration |

DATA_WIDTH |Raw & Rd

LANE_WIDTH |8 Lanes |

BUFF_DEFTH 200

Video Interface: |MNative ﬂ
testbench: User |
License: " RTL (® Encrypted

Help > OK Cancel ‘

HDMI TX IP Configuration

HDMI Tx IP core is configured in Single bit mode for native interface. HDMI Tx IP encodes video,
auxiliary, and control data to Transition-minimized Differential Signaling (TMDS) data, which pass
through transceiver.

Figure 3-7. HDMI TX 2.0 IP Configuration using Single-bit Mode for Native Interface
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—{DATA_B_1[7:0]
—v_sync_I
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Symbol

3.2 I/O Ports (Ask a Question)
The following table lists the important I/0 ports of the design.
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3.3

Table 3-1. Input and Output Ports

LANEO_RXD_N
LANEO_RXD_P
LANE1_RXD_N
LANE1_RXD_P
LANE2_RXD_N
LANE2_RXD_P
LANE3_RXD_N
LANE3_RXD_P
LANE4_RXD_N
LANE4_RXD_P
LANE5_RXD_N
LANES_RXD_P
LANE6_RXD_N
LANE6_RXD_P
LANE7_RXD_N
LANE7_RXD_P
LANEO_TXD_N
LANEO_TXD_P
LANE1_TXD_N
LANE1_TXD_P
LANE2_TXD_N
LANE2_TXD_P
LANE3_TXD_N
LANE3_TXD_P
REF_CLK_PAD_N
REF_CLK_PAD_P
CLK_IN

RX

TCK

DI

™S

TSRTB
SLVS_EC_XCE
SLVS_EC_XMASTER
SLVS_EC_RSTN
CLK_50MHZ
TDO

SLVS_SCL
SLVS_SDA
GPIO_OUT_0[3:0]
X

Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Output
Output
Output
Output
Output
Output
Output
Output
Input
Input
Input
Input
Input
Input
Input
Input
Output
Output
Output
Input
Output
Input and Output
Input and Output
Output
Output

Clocking Structure (asa question)
The design uses the following on-board clocks:

Lane0 RX channel N
Lane0 RX channel P
Lane1 RX channel N
Lane1 RX channel P
Lane2 RX channel N
Lane2 RX channel P
Lane3 RX channel N
Lane3 RX channel P
Lane4 RX channel N
Lane4 RX channel P
Lane5 RX channel N
Lane5 RX channel P
Lane6 RX channel N
Lane6 RX channel P
Lane7 RX channel N
Lane7 RX channel P
Lane0 TX channel N
LaneO TX channel P
Lane1 TX channel N
Lane1 TX channel P
Lane2 TX channel N
Lane2 TX channel P
Lane3 TX channel N
Lane3 TX channel P
Reference clock N
Reference clock P

27 MHZ of CLK

RX for UART Interface
TCLK for Flash Pro Debug
TDI for Flash Pro Debug
TMS for Flash Pro Debug
TSRTB for Flash Pro Debug
Serial Communication Interface XCE Pin for i2c (Fixed to HIGH)
Master/Slave Select (Slave Mode: HIGH, Master Mode: LOW)
SLVS Camera Reset

50 MHz of On Board Clock
TDO for Flash Pro Debug
SLVS Cam 12C SCL

SLVS Cam 12C SDA
GPIO_OUT_0 is connected to LEDO, 1, 2, 3.
Tx for UART Interface

+ The 27 MHz oscillator is used to provide a reference clock to PF_CCC_CO
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+ The on-board 50 MHz clock, which is driven as DDR Reference Clock, Processor Sub System, and
UART Interface

+ The XCVR TX PLL subsystem generates a bit clock and XCVR receives

* The LANEO_RX_CLK_R XCVR Clock provides a reference clock to PF_CCC_C3 and generates 59.4
MHz

The following figure shows the clocking structure of the design.

Figure 3-8. Clocking Structure

LANEO_RX_CLK_R
PIXCO_CLK
XCVR > ccc_c3 — >
DDR Write
CLK_50MHz CLK_50MHz
——| CCC.C1 > UART IP
»| DDR Arbiter
_ | Processor
" | Sub System
SYS_CLK (200 MHZ)
»| PF_DDR4 >

DDR Read

Video

CLK_27MHz .
Processing
—_— Ccc_co > Block &
CLK_148.5MHz Display

Controller

34 Reset Structure (as«aquestion)

The SLVS-EC design is initialized upon the de-assertion of the DEVICE_INIT_DONE signal from the
PF_INIT_MONITOR block, along with the XCVR_INIT_DONE signal from the same block. In addition
to this primary reset, the design incorporates three additional resets, each synchronized with a
specific clock. The first reset, DDR_Write_reset, resets the DDR write operations and is synchronized
with the clock from the SLVS-EC Rx IP. The second reset, Video processing reset, resets all

the video processing IP and display controller IP, using the 148.5 MHz clock. The third reset,
DDR_SYSTEM_reset, resets DDR read and arbiter operations, as well as other reset operations,
utilizing the clock from the onboard 27 MHz source.

The following figure shows the reset structure of the design.
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Figure 3-9. Reset Structure
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4. Installing the Demo GUI (asa question)

To install the GUI, perform the following steps:

1. Extract the contents of the
mpf an5188 v2024pl guilVideo Control GUI V3.1.1 Installer\Volume file andrun
the setup.exe file.

2. Click Yes for any message from User Account Control. The Video Control GUI installation wizard
is displayed.

3. Confirm the installation directory locations for the GUI and the National Instruments products,
and then click Next.

Accept the license agreement, and then click Next.

5. Review the summary and click Next, then installation proceeds with a progress bar. After the
installation, a confirmation message is displayed.

6. Click Next to exit the installation wizard.
7. Restart the host PC, when prompted. The Video Control GUI is installed.

For more information about the related steps, see DG0849: PolarFire 4K FPGA Dual Camera Video
Kit.
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5. Setting Up the Demo (asa question)

Setting up the demo involves the following steps.

5.1 Setting Up the Hardware (as«a auestion)
The following figure shows the hardware setup of SLVS-EC FMC with PolarFire video kit and interface
with HDMI display.

Figure 5-1. Setting up the Hardware

USB - UART Pl e SLVS EC FMC
UARL T 4 .<Card VIDEO-
Ternimal J R ard YIDE

HDMI 2,0
X &°

PolarFire Vi nd Imaging
MPF300-VIDEO-KIT-

The following table lists the jumper settings of PolarFire video kit.

Table 5-1. Jumper and Switch Settings of PolarFire Video Kit

J15 Open SPI Slave and Master mode selection

By default, select SPI master
)17 Open 100K PD for TRSTn

By default, 1K PD is connected
J19 Pin 1 and 2 Default: XCVR_VREF is connected to GND
)28 Pin 1 and 2 Default: Programming through the FTDI
J24 Pin2and 4 Default: VDDAUX4 voltage is set to 3.3V
J25 Pin 1 and 2 Bank4 voltage is set to 3.3V
J36 Pin 1 and 2 Default: Board power up through the SW4
SW4 OFF/ON Power ON\OFF slide switch
SW6 OFF User slide switch

Default position: OFF
J20 12 Volts Input 12V input to the board

For setting up the hardware, perform the following steps:

Connect the VIDEO-DC-SLVS to the J14 FMC Connector on the PolarFire video kit.

Connect the power supply cable to J20 of the PolarFire video kit.

Connect the host PC to the PolarFire video kit through J12 using a USB mini cable.
Connect the HDMI monitor to J1 (HDMI 2.0 transmitter (Tx) port) of the PolarFire video kit.
Power up the HDMI monitor.

Power up the board using the SW4 slide switch.

oV A wWwN =

5.2 Programming the Device using FlashPro Express (asa auestion)

To program the PolarFire device with the . job file provided as part of the design files using the
FlashPro Express software.
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This section describes how to program the PolarFire device with the . job file using
FlashPro Express. Thempf an5188 v2024pl df.job file is available at the following location:
<download folder>\mpf an5188 v2024pl ijb

To program the PolarFire device with the . job file, perform the following steps:

1. Onthe Host PC, start the FlashPro Express software from its installation directory.

2. To create a new job project on the Project menu, click New or New Job Project from FlashPro
Express Job.

3. Inthe New Job Project from FlashPro Express Job dialog box, perform the following steps:

- Programming job file: Click Browse and navigate to the location where the
mpf an5188 v2024pl df.job fileis located and select the file. The default location is
<download folder>\mpf an5188 v2024pl df\Programming Job

- FlashPro Express job project location: Select Browse and navigate to the location where you
want to save the project.

Figure 5-2. New Job Project from FlashPro Express Job

[Z3 Create Mew Job Project X
Creaste 2 new job project by importing FlashPro Express job file.
Switch to per mode if no programmer s connected or to reload programming files and enable additional features,

To switch to developer mode go to Project, Preferences, FlashPro Express Mode.
(® Import FlashPro Express job file

}_an 5188 w2024pi_dffdesigner\VIDEO_KIT_TOP\exportympf_anS188 vI024pl_df job Browse...

to construct chain automatically and load programming files.

To switch to developer mode go to Project, Prefersnces, FlashPro Express Mode.

" Construct automatically {developer mode)
Connected programmers 1 _J Refresh
Progra ng interface: TAG

FlashPro Express job project name: | o

FlashPro Express job project location: |E=1\dE|E1E Browse...

e e

4. Click OK. The required programming file is selected and ready to be programmed in the device.
The FlashPro Express window appears.

5. Verify that a programmer number appears in the Programmer box. If it does not, verify the
board connections and click Refresh/Rescan Programmers.
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Figure 5-3. Programming the Device
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6. To program the device, click Run. When the device is programmed successfully, a Run
PASSED status is displayed, as shown in the following figure.

Figure 5-4. FlashPro Express—RUN PASSED
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7. To Close FlashPro Express, click Project > Exit. The PolarFire device is programmed.
8. To Power cycle the board, press the SW4 switch. After power cycling, the full HD displays the

video from the camera.
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6. Running the Demo (asa question)

Running the demo involves verifying the imaging and video settings using the Video Control GUI,
and then observing the video output on the HDMI monitor.

To use the demo GUI, perform the following steps:

1. Start the Video Control GUI from the installation directory, see the following figure.

Figure 6-1. Video Control GUI
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MICROCHIP e O Hisogram Reset

2. Inthe I/0 list, click the second largest COM port, and then click Connect.

Figure 6-2. Connecting the GUI and Video Kit
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The following figure shows that the Connect button turns green indicating a successful
connection.
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Figure 6-3. Connection Successful
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3. Move the corresponding sliders appropriately to adjust the contrast and brightness and observe
the change on the HDMI monitor.

Figure 6-4. Adjusting Contrast and Brightness
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4. Similarly, move the sliders to adjust the color balance of the image using the color balance
sliders.
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Figure 6-5. Color Balance

D Vedeo Control GUI V310

Video Control GUI

— b

122

E N N T N N RO
0 30 1M 130 20 255
Color Balamce : Gresn
O B
I R R
0 50 1M 130 200 255
Color Balanoe : Bhee

1 G000
O R T R T
0 5 1M 1% 200 255

=
E
-
=
=
-
LA
=
=]

(=3

=
5
L

154
lastbprmaqpimantjas KL

138

2-
Z
-
(=1
=
-
-
=
)
Z2
[
Ln
(4]

9 Important: PIP Menu, Panning, Histogram, and Edge Detection options are
not supported in this demo.
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7. Appendix A: Running the Tcl Script (s auestion
Tcl scripts are provided in PolarFire Video Kit Reference Design.
To run Tcl, perform the following steps:
1. Launch the Libero software.
2. Click Project > Execute Script.
3. Inthe downloaded mpf_an5188_v2024p1_df directory, select script.tcl.
4. Click Run.

After successful execution of the Tcl script, the Libero project is created within the top directory. For
more information, check the Log file mpf an5188 v2024pl df log.

For more details about the folder structure of mpf an5188 v2024pl df and Tcl scripts and
commands, see the TCL, Scripts readme.txt and Tcl Commands Reference Guide. Contact
Technical Support for any queries about running the Tcl script.
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8. Revision History (saauestion)

The revision history describes the changes that were implemented in the document. The changes
are listed by revision, starting with the current publication.

Table 8-1. Revision History

B 06/2024 The following is the list of changes in revision B of the document:
+ Updated Figure 3-1 and Step 1 in 3. Design Description section

+ Updated Figure 3-4 and Figure 3-7 in 3.1. Hardware Implementation section
+ Updated Figure 5-1 and added Table 5-1 in 5.1. Setting Up the Hardware section
+ Updated . job file location in 5.2. Programming the Device using FlashPro Express section

+ Updated 7. Appendix A: Running the Tcl Script section

A 04/2024 Initial release
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Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:
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